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1 Overview

This document is a user guide to the Apache Roller Weblogger, the Java-based and open sourceweblog server
that is produced by the Apache Roller project of the Apache Software Foundation.

There are separate guides available on other topics; an Template Guide for those who wish to customize the layout
and design of their weblog pages and anlnstallation Guide for those installing the Roller software on a web
server.

1.1 Copyright and trademark information

The contents of this document are subject to the terms of the Apache Software License.

All trademarks within this document belong b legitimate owners.

1.2 Feedback

Please direct any commentsor suggestions about this document to: dev(@roller.apache.org

1.3 Acknowledgments

The general format of this document was based on the documentatim template used by OpenOffice.org.

1.4 Modifications and Updates

Date Description of Change

August 11,2007 Rewrites and updates for Roller 4.0, Dave Johnson
July 5, 2007 New format/layout, Dave Johnson

July 31,2007 Roller 4.0 updates from Linda Skrocki
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Introduction

This user guide describes how to use the Apache Roller Weblogger or Roller for short, a web application that can
support a single user weblog, thousands of weblogs and/or group weblogs.

You'll learn how to register as a new user. You'll learn how to create one or more weblogs for yourself or a group
of your friends. You'll learn how to create, edit and post weblog entries. We will also cover more advanced topics
such as adjusting your weblog's setings, how to customuize your blogroller, how to manage weblog pings and

more.

First, let's get some terminology out of the way because there's a lot of jargon in weblogging. Here's a list of some
of the terms we use in this manual without a whole lot of background.

Weblog: A set of web pages and RSS/Atomfeeds that display weblog entries written by one or more
authors, uploaded images, bookmarks and comments posted by visitors. Weblog entries are displayed on
the main page of the weblog and in the weblog's feeds in reverse chronological order.

Weblog entry. A single weblog entry wth a title, publication timestamp, summary, content and some
settings that indicate if and when commentsare allowed.

Comment. A comment posted by a vistor to a weblog and regarding one specific weblog pst. A comment
has an email address, a publication timestamp andsome content.

Trackback. A comment posted by a remote weblog regarding one specific weblog post. Trackbacks are
stored as commentsby Roller.

Templates. Each Roller weblog isdefined by aset of HTML and CSS templates that provide the layout
and styles for the weblog. Normally templates are authored using Velocity template language, but other
languages are possible via plugins (i.e. Groovy Server Pages, JRuby, etc.)

Feed. A feed is an XML representation of the most recent entries, comments or other data. Folks can
subscribe to your feed to be alerted of new weblog entries and comments posted. Roller supports both RSS
and Atom formats for feeds.

Feed reader. Software that makes it easy to subscribe to and read feeds, e.g. Google Reader, Net News
Wire, Feed Demon, etc.

Blog client. Software that makes it easy to post to your weblog, e.g. Ecto and Mars Edit.

With that out of the way, let's get started blogging with Roller.



3 Getting started with Roller

Getting started with Roller means different things to differernt people. If you are using an existing Roller server,
then getting started means registering a new user and creating or joining a weblog. If that's the case for you, skip
ahead to section 3.2. If you just finished setting up your own Roller installation on your own webserver, then
getting started means a little bit more. You've got a little post installation work to do.

3.1 Getting started with a new Roller installation

Once you've got Roller up and running you will see a screen like the one below, which explains exactly what
you've got to do to get started wih Roller. First, create a new user so you can login. Second, login and create a
weblog for yourself or one to server as the front page of the site or both. Third, designate which weblog is the
front page weblog.






Front Page | Main Menu | Login | Register
Welcome to Roller!

Follow these steps to finalize your Roller installation:

+ Create a user
Before you can start to use Roller, you need to create a user so you can login, manage Roller
and start blogging. Mote that the first user you create will be given the Globar Adrain rights
necessary to manage Roller, manage Roller users and designate other Global Admins.

Create your first user via the MNew User Registration Page .

*

Create a weblog

Before you can start blogging, you need to create at least one weblog. Just so you know, you
can create as many as you want. Each Roller user can have multiple weblogs and each Roller
wehblog can have multiple authors.

Create your first weblog via the Mew Weblog Creation Page

*

Designate a frontpage weblog

You must specify a weblog to serve as the frontpage of your Roller site. You can do this by
going to the Server Admin->Configuration page. In the field labelled "Handle of the wehlog
to server as the frontpage” enter the handle of the weblog you want to front your site. Once
you're done you won't see this iritating page any longer.

Designate a frontpage weblog on the Server Admin Page

Powered by Apache RollerWeblogger Wersion 4.0-dev | Report an lssue | User Guide | Mailing Lists

Illustration 1: Welcome to Roller

Creating the first user. Your first step is to create a new user. Remember, the first user you create will be given
administrative privileges. You might want © use the username "admin" or something similar. Later, you can login
as the admin user whenyou need to change site-wide settings. If you wish, you can grant other users admin
privileges so they canhelp out with admin duties. Let's take a look at the user registration page. You can see the
new user registration form in the next section.

Create the first weblog(s). Next you should create at least one weblog. See section 3.2 below for some more
information the create weblog page. If you are running a personal blog site, then you might want your weblog to
serve as the front page of your site. In that case, create a weblog, use a normal weblog theme(i.e. not the Roller
Homepage theme) and assign your weblog as the front page weblog of thesite.

If you are running a communty weblog ste with multiple weblogs, then you will probably want to createa weblog
to serve as the front page of the site. Create a new weblog, nameit "main" or "community" orsomething suitable
because it's name will appear in URLs. And we recommend that you use the RollerHomepage theme because it is
specially designed to serve as a weblog comminity front page,aggregating all of the site's weblogs together but
having no content of its own.

Designate a front page weblog. Once you've created a front page weblog, whether it be a personal weblog or a
community aggregator, you need to tell Roller. So, follow the link to the Server Admin page and look for the Site
Setting section. Enter the handle of your front page weblog and, if you are running a community site then set the
Enable aggregaed site-wide frontpage checkbox beforeyou click Save.

If you've read this far, you've probably created your own user and weblog and if so you can skip the next section.



Site Settings

Site Mame (for main page and RSS feed) IRD”e,- Site

Short name (shown in site banner) Ime Page

Site Description (for main page and RSS feed) L default install of the

Roller Weklogger cpen
scurce klog Server

Handle of weblog to serve as frontpage blog Imain

Enable aggregated site-wide frontpage [w]

Hllustration 2: Weblog Settings page: Site Settings

3.2 Creating a new user and weblog

To create a new user use the Register link, which can be found in the top right of the Rollerlogin page. That link
will take you to the New User Registration page shown below.



New User Registration

Use this form to register a new Roller user, please create only one user account per person.

Usermname | A short one-word username for your user account.
Flease limit it to simple ASCI alphanumeric
characters (a-z, A-Z and 0-9), and do not use HTWL.

Fassword Your password.

Fassword (Confirm) Confirm your passwaord.

Screen Name Your desired screen name (with no HTML).

Full Mame Your full name {with no HTML).

Email Please enter valid email address, the site
administrator may disable your account if he/she
cannot reach you via email.

Lacale | English | Your preferred locale.
Timezone | IUS/Eastern =l Your preferred timezone.
Register User | Cancel |

Hllustration 3: New User Registration page
The New User Registraton form is pretty self-explanatory, but keep in mind that your username cannot be
changed; it is your unique identifier in the system. But that's OK because your screenname is the name that will
be displayed on your weblog and in your feeds and you can change it later if you wish.

Picking your language and timezone. You can set your language of choice and timezone too, but these values
don't do muchin Roller. The locale and timezone of your weblog are really what matter. The values you set here
will be used as your defaults when you createyour weblog.

Creating a weblog . Once you've created a user, then login and you'l see the Roller Main Menu page and a
greeting that reads:

You've got a user account, but no weblog. Would you like to create one?
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Follow that link to create your first weblog. You'll see the form below.

ogged in as fred Front Page | Main Menu | Logout

Create Weblog

Use this form to create a new weblog for you or for you and a group of your friends.

Name | The name is the title of your wehblog, it will be displayed atthe
top of your weblog page, and in the title field of your weblog's
newsfeed. This field should notinclude HTML.

Description | The description of your wehlog may be displayed at the top of
yourweblog {depending on the theme you choaose), and it will
he used in description or subtitle field of your newsfeed. This
field should not include HTML.

Handle The handle is a short one-word name for your weblog. [t will be
URL: hitp:fpurple:8080irollerhandle used inyour URL, so please limit it to simple ASCII
alphanumeric characters (a-z, A-Z and 0-8), and do not use
HTML.
Email Address Fred@example.com Your email address orthe email address of the person

responsible for the weblog that you are creating.

Locale | English =l The default locale to be used for the display of this weblog when
the browser does not specify a locale.

Timezane | IUS/Eastermn ;l The timezone to be used for entry and display of this weblog.
Theme | Roller Homepage ~| The theme to be used to display this weblog. Later, you can

easily switch to another theme or edit the themes templates to
: customize it to your liking.

Eﬂllerl

Roller Weblogger Project B e

e

Create Wehlog | Cancel |

Hllustration 4. Create Weblog page
The form is designed to be self-explanatory. Note that you can change everything later, except for the weblog

handle, which is the unique indentifier for your weblog.

Now that you've got auser and a weblog, let's discuss how to get around in the Roller interface.

11



3.3 Getting around in Roller

Once you've logged into Roller's editor pages you should be able to find your way around using Roller's tabbed
menu. To provide a little extra assistance, Roller displays a status bar at the top of each editor page.

For example, the status bar below indicates that you arelogged in as user 'admin' and you are not editing a
weblog. You cango directly to the front page of the site by clicking the first link on the right (it might not be
labelled Front Page on your site), to the main menu with the second link and you canlog out entirely by using the
Logout.

logged in as admin Froni Page | Main Menu | Logout

Hlustration 5. Status bar, no weblog

For example, the status bar below indicates that you arelogged in as user 'admin' and you are editing a weblog
with the handle 'adminblog'.

logged in as admin - editing weblog adminblog Fronl Page | Main Menu | Logoud

Hllustration 6: Status bar within weblog

If you are not logged into Roller then you can either access the login link directly or use a Login link from one of
the weblogs on the site. The login link is of this form:

http://hostname/roller-ui/login-redirect.rol

Or this form is Roller is installed under it's own cortext:

http://hostname/roller/roller-ui/login-redirect.rol
You probably won't need to cut-and-page that link because most weblogs display an author menu like so:

MNAVIGATION

Front Page
About
Weblog
Login

Hllustration 7: Weblog navigation bar

Now that we've covered the basics ofregistering a new user, creating a new weblog and finding your way around
let's start blogging.

12



4 Creating and editing your weblog

First, you login to Roller. What happens next depends on the numberof weblogs that you have. If you have one
weblog, you'll be taken directly to the New Entry page for that weblog.

If you have more than one weblog or none at all, then you'll be taken to the Main Menu page, shown below, so
you can pick which weblog to edit and/or create new weblogs.

logged in as TyroneSydneyShannon

Front Page | Main Menu | Logout

Main Menu Actions
Select a weblog to edit, manage, or configure.

Create new weblog

Feellike you've got more to say?
Maybe anotherwehlog is whatyou
need.

—I UberHistoryBlog

Link

hitp:ipurple:g0adirollerUberHistoryBlog

\.,.J' Mew Entry

Permission ADMIMN .
. c Edit ofil
Description & blog named Uber Histary Blog (= Entries (50) user profie
Members: 1 & Comments Change password, contact infa,
Today's hits: 0 (300) select language.
| Theme
i Settings
—1 CoolMusicBlog
Link hitp:ipurple:8080froller/CoolMusicBlog 1 .
Permission ADMIM = NE"T Em'f
Description A blog named Coal Music Blog (= Entries (50)
Members: 1 & Comments
Today’s hits: 0 (300)
] Theme
i Settings

Hllustration 8: Main menu

The main menu page lists all of your weblogs and for each, shows you links to its New Entry, Entries, Comments,
Theme and Settings pages. You canalso create a new weblog, edit your user profile.

If you are logged in as a Global Administrator, you will also see a Server Admin link in the actions side-bar. And
if you have Roller's Planet aggregator enabled, then you will also see a Planet Admin link there as well.

13



4.1 Creating and editing a weblog entries

Use the Create & Edit-> New Entry page (also known as the Weblog edtor page) to create, edit and publish
weblog entries. Using the page, shown below in illustration 7, you can set entry title, category, content and
summary. You can also set some advanced settings by expanding the Plugins To Apply and Advanced Settings
controls at the bottom of the page. Let's review those fields, buttons and settings.

Hlustration 9: Weblog editor

Editing weblog entry in weblog roller

Tille |Statesuil|e balloon-fest
Stalus Published {Lasiupdaied 10/30/06 10:17 PM)
Permalink hitp:/frollerweblogger.ong/rollerentry/state sville_balloon-fest
Cafegory /General ll
Tags I'farﬂil',r photos vacation
Conient
7] | [wammat ][ —font — T —see— =B I US| Ad[A] xxX|=E=E==

e
[
1T
Il

i

[
¥

El—@e@ao 9 cBI Ba2 42 M E@@

Crwer the weekend, we drove about three hours west towards the mountains to Stateswille, NC for the
anmal Carolina balloon-fest. We saw a tank, an assortment of military helicopters and we even saw
some balloons attempt to inflate. Unfortunately, it was way too windy for ballooning, So it was a bit
frustrating, but the kids love any chance to take a road trip so it wasn't a total loss, You can see some
of my photos on Flickr.

Path: body = p

Summary {(opfional)

I—fon'rElt— j|—font— j|—siza—j A

FPath: bady

+  Plugins To Apply

+ Advanced Settings

Post to Weblog Save as Draft I Delete Entry Full Preview

14



4.1.1 Weblog editor fields

Let's discuss each of the fields on the New Entry page, so you know how to use them.

Title — Each weblog entry must havea title. Be careful when you pick your title, it will be used in the link
to your weblog entry. Forbest results, do use titles that are short and to-the-point. Don't include any
HTML in your titles, just plain text — if you want your titles to be bold, then customize your templates
instead of embedding HTML in your titles.

Status — This read-only field tells you about the current state of the weblog entry that ya1 are editing.
There are three possible status settings:

e Not Saved— the entry has never neen saved
e Draft — the entry is saved as a draft and is not yet vsible to your weblog's readers
e Published — the entry has beenpublished and is visible to your weblog's readers

Permalink — this read-only field is the permalinklink to your weblog entry. It is set the first timethat you
save an entry, based on the title at the time you save — and it cannot be changed later.

Category — You can pick one category for your weblog entry. Categories are for folks who want to
organized the entries in their weblg into a small-set of fixed and possble hierarchical categories, defined
by the weblog admin (that's probably you). You can add and remove categories via the Categories page.

Tags — (optional) In addition to assigning each of your weblog entries to a category you can also tag them.
You can assign a list of tags to eachentry. You canuse any tag name you want. Separate your tags with
spaces. Currently, the only way to do multi-word tags is to use an underbar, for example to tag something
with "apache roller" you would use the tag apache roller.As you type, Roller may suggest tags that you've
used before.

Content — This is the main body of your weblog entry,in HTML format. We try to make that easy by
providing two ways to edt the content. Via the Setttings page, you can pick either of these:

e Rich Text Editor (Xinha) — a rich-text editor that's designed to make editing HTML as easy as
using MS Word or Open Office.

e Text Editor — a plain-text editor that you can use to edit the raw HTML markup of your weblog
entries. Don't use this unless you know HTML.

Summary — (optional) If you wish, you can enter a short summary of your weblog pest. If you do so, then
the short summary will be displayed on the mainpage of your weblog and your readers will have to click a
Read More link to get to the full-content. Some bloggers like to do this when they have very long post and
they don't want that long post to dominate the main page of their weblog.

4.1.2 Weblog editor buttons

Here's a guide to the buttons that appear on the Weblog editor page.

Post to weblog — Using this button will publish your weblog entry and make it visible to the world. Make
sure you're happy with your post before you publish because once something s published on the web, and
grabbed by the blog aggregators and search engines, there's really no way to un-publish it.

Submit for review — if you're just a limited blogger, you won't see the Post to weblog button because you
cannot post to the web. Instead, you'll see a Submit for review button which you can use to send your entry
to the author/admin of the blog that you are working in. If they like the post, they can publish it — or they
can return it to you for further edits.
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e Save as draft— this will save your weblog post for later editing, but will not publish it to the web. When
you're working on anew weblog entry, use Save as draft often so you won't Ise your post in the event of
internet connection loss or session time-out.

e Delete entry — use this to delete the currentweblog entry, you'll be asked to confirm.

e Full preview— You won't see this button until you've saved your entry as a draft. It allows you to view, in
a separate window, a preview of your entry, displayed using the layout and style of your blog.

4.1.3 Weblog editor plugin settings

If you expand the Plugins to Apply control, you'll see a set of check-boxes, one for each Weblog Entry Plugin that
is available. Check the ones that you'd like to apply to your current weblog entry. If you have a favorite plugin,
one that you want to use on everyentry, then you canset it as a default on your weblog's Settings page.

- Plugins To Apply

™ JsPWiki Syntax 7
I"’_ Topic Tags 7
I_ Emoticons 7

4.1.4 Weblog editor advanced settings

If you expand the Advanced Settings control, you'll see what's below.

- Advanced Settings

Pub Time
f22 =|:|10 =|:|30 =| [10/3008 7| AmericalNew _York

|"_ Allow comments fcrl T days ;l

™ Text reads rightto-left
I_ Pinned to main

Enclosure URL: I

All of these are optional settings.

e Pub Time — if you'd like to set the publication time of your weblog entry to a specific time, possibly one
in the future, you can do so here.

e Allow comments for — this setting allows you to turn commentson/off for your weblog entry and to limit
the number of days that comments are allowed.

o Text reads left-to-right — this settings allows you to set the readsleft-to-right flag for a weblog entry.
Currently, none of the stock Roller templates respectthis setting.

e Pinned to main — only Global Administrators will see this setting. It's a way to indicate that a post is a
special announcement that should be pinned to the top of the front-pageof a weblog site. The front-page
theme respects this setting).

e Enclosure URL: if you'd like to include a audio, video or image file as a podcast in your weblog's RSS
feed, then enter the URL of that file here.
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4.2 Finding and editing weblog entries

All of your weblog entries aresaved in a database. Once your entries scroll off the front page or off the recent
entries list of the weblog editor page, they are still available via next and previous links displayed on your weblog
and via the weblog calendar that is included in most weblog themes.

You can also access your entries via the Edt Entries page, which allows you to searchentries via keyword,
category, tags, date and status.

logged in as TyroneSydneyShannon - editing weblog UberHistoryBlog Front Page | Main Menu | Logout
Edit Entries
m Design Preferences

Mew Entry | Entries | Comments | Categories | Bookmarks | File Uploads | Referrers

Find and edit entries in weblog UberHistoryElog Filter entries

You can select an entry from the list below to edit or use the Filter entries control to look

for entries in a specific category, date range or status. E!tt';' fﬁ:ﬂ.lgrg;;]tt:;iss by category,

Displaying 30 weblog entries 072707 07:89 AM - 06/16/07 07:59 AM Category Any =]

« Previous page | MNext page » Tags I—
. Seanch
[ ]oraft [ |Pending oy I
Start Date: ‘ﬂ
07/27/07 0811107  Lorem ipsum dolor sit Java Edit | View S bates =
07:59AM 0759 AM iz " All Entries
a7iz4/07 08/11/07 | Fusce feugiat neque id General | Edit |View " Dratt Only
07:50AM | 07:58 AM " Published only
07/24/07 | 08/11/07 |Maecenas utjustoid| Politics Edit | View " Pending Only
07:59 AM | 07:59 AM
07i04/07 08i11/07 |M tjustoid | Politi Edit | Wi P EHECHEC
aecenas utjustoi olitics dit |View Sort by: A
0759 AM | 07-59 AM " Publish time
- ) = Update time
07/04/07 08/11/07 Phasellus sodales, qua Java Edit | View Eilt
07:59 AM | 07:59 AM _Fiter |
a7i11/07 08/11/07 | Lorem ipsum dolor sit Java Edit |View

07:59AM  07:59 AM

Hlustration 10: Edit entries page
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4.3 Managing categories

Each weblog can define its own unique list of categories to be used for categorizing weblog entries, using the
Categories page shown below. When you or another author of your weblog createsa new entry you must choose
one of the categories you have defined.

logged in as roller - editing weblog roller rollerweblogger.org | Main Menu | Logout

Categories

m Design Prefarences

New Entry | Entries | Comments | Categories | Bookmarks | File Uploads | Referrers

Manage categories in weblog roller Actions

These are your top-level weblog categories. You can use categories to organize

your wehlog entries and your readers can choose to subscribe to separate —o Add Category
newsfeeds for each of your categories. You can also define sub-categories, but

many of the Roller macros display only top-level categories.

Check All | Check Nane | Mave |[/ =

[~ | = |Links & @
™ | = | Microsoft & @
[~ | = |Sun & @
[~ | [ |Feeds & (=]
[~ | &= [Mac & @
[~ | [ | Blogging F =]
[~ | 2 |Open Source & @
™ | = [Raller & @
™| = | General & @
| = |Java & @

Hlustration 11: Categories page

You can use the Categories pageto add new categories andto edit your existing ones. You can change category
names if you wish. And you can also delete categories and if a category is in use you will be asked to re-
categorize the entries in that category.

You can also define a hierarchy of categories and move categories around in that hierarchy,but support for
hierarchical categories is somewhat limited in most Rollerthemes. Unless you are prepared to do some
customization via template editing, you probably don't want to use hierarchical categories.
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4.4 Managing your weblog's blogroll

Roller makes it easy to maintain a blogroll, that is, a list of your favorite weblogs and web sites that is displayed
in the sidebar of your weblog. Individual blogroll items are known as bookmarks. Use the Create &
Edit:Bookmarks page to add, edit and delete bookmarks andbookmark folders in your blogroll.

Bookmarks

Preferences

Managing bookmarks in weblog [adminblog]

Actions
This is your toplevel bookmarks folder. The bookmarks you keep here will ;\
appear in the blogroll section of your blog (assuming that you are using one of *# Add Bookmark
the default themes). You can create bookmark folders here, but you will have =1 Add Bookmark Folder

to add corresponding bookmark display macros to your weblog's templates if
you wish to display their contents.

SelectAll | SelectNone | Delete selected | Move selected |[/ =

S e pcrpon— canve
&

[~ & | Allen Gilliland v

™ & | Anil Gangolli )
[ | & | blogs.sun.com ¥ @
™ & Dave Johnson )
I~ |& | Henri Yandel 7 &
[~ | & jroller.com )
[~ & |Lance Lavandowska )
™ & |MattRaible 7 &

Hlustration 12: Bookmarks management page
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4.5 Uploading images and other files to your weblog

If you'd like to upload images or other files for use in your weblog, go to your weblog's Create & Edit -> File
Uploads page. From there you can upload files and managethe files that you have already uploaded.

Upload files for use in weblog roller

You can upload files for uss in this weblog. If you've uploaded an image you can include it in your weblog via an HTML <img sre="[IMAGE-URL]" /= tag.
If you've uploaded a podeast, you can include it in an entry by providing it's URL in the entry's MediaCast field.

You may upload files smallerthan 0.50 MB in size, uptoa total of 10.00 MB for all files.

Browse...

Browse...

I Browse... |
I Browse... |
I Browse... |
Upload I

Manage Uploaded Files
New Direclory I Create

test 4 KB ~
20010808-006-walk png 208.52 KB |_
3-hook jpa 526 KB r
2003-catfound. jpg 522 KB ~
2003-catlost.jpg 494 KB ~

Hlustration 13: File-Upload page

Using this interface you can:

e Upload up to five files at a time. To upload a file click a Browse button, select the file you wish to upload
on the file-system and click the Upload button to upload it to Roller.

o C(reate sub-directories (one level deep) to organize your uploaded fils. Just enter the desired name of the
new directory in the New Directory field and click the Createbutton.

e Delete uploaded files and directories. To delete a file or directory, just check the Delete check-box them
click the Delete Selectedbutton at the bottom of the page.

How to blog an image
If you want to upload an image to Roller and then include that image in a blog post, here's what you do.

1. Upload the image you wish to use in aweblog entry. Once the upload is complete, you'll see a success
message like this with the URL that can be used to view that image.

Lplcaded file(s):
hitp:#rollerweblogger.org/rollenresouncetestiweblogeditor. png

Select that URL text and copy it (usng right-click copy or ALT-C).
Create a new weblog entry oropen an existing weblog entry in which you'd like to include the image.
If you are using the Rich Text Editor, choose the insert image button and enter the URL of the image.

A e

If you are using the plain text editor, use an <img>element to display the image like so:

<img src="http://rollerweblogger.org/roller/resource/weblogeditor.png"
alt="Image of the weblog editor" />
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4.6 Podcasting with Roller

Roller now includes support for podcasting, a way to distribute files through your weblog's newsfeed. Typically,
folks use podcaging to distribute audio files, but the technique canbe used to distribute any type of file.
Specialized podcast client software downloads the audio files that are referenced in your newsfeed and copies
them to an music player, such as an MP3 player.

4.6.1 How to create a podcast feed with Roller

In Roller a Podcast is like an attachment to a weblog entry. We call it mediacasting in he Roller Ul because it can
be any type of file and is not necessarily degined for play on an Apple iPod. Here are the steps involved in
Podcasting with Roller:

Record an interesting Podcast (that's the hardpart, by the way) and save your Podcast in MP3 formator
whatever format you prefer.

Upload your Podcast to a web server somewhere and take note of your Podcast's URL.For example, if you
were to upload a file to Roller, then the URL might look something like this:

http.//hostname/roller/vourname/resource/mycast.mp3

Create a new Roller weblog entry announcing your new Podcast. You might want to provide a link to it so
that those without a Podcast client can click to download it directly. For example:

Hey now! I just created my first Podcast you can download it here:
<a href="http://hostmame/roller/yourname/resource/mycast.mp3">mycast. mp3</a>

And the most important step: in the lower-half ofthe weblog editor page, you'll see an expandable control
labelled Advanced Settings. Click on that to expand the control and paste in the URL of your podcast.

Once your blog post is ready, save it as a draft or publish it. Once you've done that you'll see that the
Advanced Settings control has picked up the contert-type and file-size of your podcast. If not, then Roller
could not access your podcast due to network problems or perhaps abad URL. Make sure the URL is
correct and save again. If your podcast is OK,you'll see something like this:

URL: Ihttp:.-'.-'exarn ple.com/rollerresources/nina/myfirstpodcast. mp3

Post to Weblog I Save as Draft | Preview | Spell Check

Hllustration 14: Podcast URL field

Roller will add the podcast to your RSSnewsfeed as an <enclosure>. You can check this by looking at
your RSS newsfeed and any podcast software that is subscribed to your feed will pick it up automaticaly.

<enclosure url="http://example.com/roller/nina/resource/mycast.mp3"
type="audio/x-mpeg" length="3409127" />
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4.7 Using aweblog client with Roller

Using a nice weblog client like Ecto or MarsEdit can make it easier for you to post to you Roller weblog. You can
also post to your weblog remotely from services like Flickr.com and del.icio.us. Ths is possible because Roller
supports a standard publishing protocols such as the MetaWeblog API and the Atom Publishing Protocol. Here's
how to setup a weblog client to post to Roller.

Configuring a weblog client for use with Roller

First, make sure to enable weblog cliert API support in your weblog via your weblog's Weblog Settings page.

Weblog Client API

Enable Blogger and MetaWeblog APls for your weblog? &
Categary for posts received via Blogger AP fLinks =

Hllustration 15: Weblog Settings page: Weblog Client APl

Next, start your blogging client, find the preferencesor account setup dialog. You'll need to set the following
parameters:

e Username: your Rollerusername

e Password:  your Roller password
e BloglD: the handle of'your Roller weblog
e URL: the URL of Roller's web services end-pant

Note that you maynot need to enter your BlogIDbecause some blog clients will login to Roller and then present
you with a list of the weblogs that are available to your user.

A blogs.sun.com example. For example, if you have an account on blogs.sun.com, your username is fred and
your blog's handle is fredsblog (i.e. your weblog's URL is http://blogs.sun.com/fredsblog), then your paramrters
would be:

e Username: fred

e Password: (yourpassword)

e BloglD: fredsblog

e URL: http://blogs.sun.com/roller-services/xmlrpc

You may not need to enter your BlogID because some blog clients will login to Roller and then present you wth a
list of the weblogs that are available to your user.

A jroller.com example. If you have an account on jroller.com, your username is fred and your blog's handle is
fredsblog (i.e. your weblog's URL is http://jroller.com/fredsblog), then your paramters would be:

e Username: fred

e Password: (yourpassword)

e BloglD: fredsblog

e URL: http://jroller.com/roller-services/xmlrpc
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5 Working with comments and trackbacks

Roller supports weblog comments and trackbacks, which provide a way for other bloggers to add commentsto
your blog remotely. By default commentsand trackbacks are enabled, but you can turn them off on your weblog's
Weblog Settnigs page of your weblog. Note that turning off comments, disables both comments and trackbacks.

5.1 Comment notification via email

If you're going to leave comments turn on then take the timeto read them, to respond where appropriate and,
when you receive spam or other forms of offensive comments, delete them from your weblog. You can't respond
to comments if you don't know when you get one, so make sure you enable email notification of comments. You
can do that on the Weblog Settings page.

If you've got email turned on then you'l receive an email every time you get a new commentand the email will
include the text of the comment, a link to the entry that was commented upon and a link to the comment
management page, shown below, where you may choose to approve, mark as spam or even delete the new
comment.

5.2 Comment management

You can use the Comments page to manage your weblog comments. You can mark comments as spam or delete
them entirely. You can search comments by keyword, dateand status. If you've got commentmoderation turned
on, you will use the Comments page to approve new comments.

logged in as TyroneSydneyShannon - editing weblog UberHistoryBlog Front Page | Main Menu | Logout

Comment Management

!reae !!!H Design Preferences

MNew Entry | Entries | Comments | Categories | Bookmarks | File Uploads | Referrers

Manage comments in weblog UberHistoryElog Filter comments

You have comments. You can change approval, spam status and delete comments via the
checkboxes helow. If you make any changes, he sure to save them by clicking the Save changes
atthe bottom of the page.

Filter comments by search string,
status, andior date

. . Search string: I
Displaying 30 comments 08/11J07 07:59 AM --- 08/11/07 07:59 AM
. Start date: _"I
« Previous page | Mext page » I
End date: =
=
Pending o Al
Select Select  Select status r Pgn.:”ng ':Ilﬂ",l'
Al All All [ |Pending [ |Spam Y
None | Mone | Maone P4 (UG alf)
Disappoved only
[+ - - Regarding Loremn ipsum dolor sit pRey !
Posted by Elizabeth Simpson Rockberry from IP address Spam status @ )
Posted at 8/11/07 | : £ No spam
¢ Only spam
Lorem ipsum dolor sit amet, consectetusr adipisc M

Nam ultricies, diam id cursus ultrices, tellus p
rutrum metus sem sed quam. Nam consectetuer dolo
malesuada, ligula eget porta nonummy, felis orei

Hllustration 16: Comments page
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A word about status

You can't edit comments, but you can mark them as spam or dis-approve them. Currently, Someday, Roller may
provide some spam filtering based on data collected from comments marked as spam but currently, marking as
spam and dis-approving of acomment do the same thing -- they prevent the commentfrom being displayed on
your weblog.

How to get to the Comments page

There are a couple of ways to get to the Comments page. You can use Roller's tabbed menu to go thereand
manage comment across your entire weblog. If you've got email notification of new comments turned on, the you
might arrive at the Comments page via a link sent to you in your email.

You can also manage comments for just one weblog. When you are editing a weblog entry with comments you'll
see a link in the top-right corner of the weblog editor page like the one below, which you canuse to access the
entry's comments.

5.3 Comment moderation

If you'd like to preview and approve commentsbefore they are displayed on your weblog, then you'll want to turn
on comment moderation via Weblog Settings page. When comment moderation is enabled, then each new
comment will be marked as pending and unapproved and wil not appear on your weblog. To check for new
comments, go to the Comments page to check for and either approve or delete new comments. If you've got
comment notification enabled, makesure you also enable comment notification so you'll know when new
comments arrive. To moderate comments, use the comment management page, described below.

How to moderate comments

« Review each new commentand decide if it is to be approved for display, marked as spam and hidden or deleted
entirely.

+ Only comments that are marked as approved and arenot spam will be displayed on your weblog. So set (or
unset) the correspondng checkboxes for each comment, or leave them the way they are.

« When you are done. Click the save changesbutton at the bottom of the page. You'll see that comments that
were pending are no longer pending and those that you marked for delete will be gone.

5.4 Global comment management

If your user has global adminstration privileges, then you can manage comments across the entire Roller site,
including every weblog. To do this, go to the Server Adminstation:Commentspage and you'll see a page that is
almost identical to the weblog-specific comment management page.

Limitations of global comment management

You can use this page to mark as spam or delete any comment in the system, however you cannot changethe
approval status of comments through this interface. Approving comments for display is the duty and responsibility
of the individual webloggers, so comment approval is only available in the context of aweblog.
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5.5 Preventing weblog spam

There are three forms of comment spam that can affect your weblog:

«  Comment spam: spam that arrives via the commentform on your weblog. Sometimes spam comments are
added by a human and sometimes by a computer program known as a spambot.

« Trackback spam: spam that arrives via trackbacks sent by a spambot.

« Referrer spam: spam that arrives in web requests and appears on the Referrers page of your Roller blog or
on your blog (but only if your blog theme uses the #showRef er r er s() macro).

Fortunately, there are counter-measures for each type of spam. Here are Roller's built in spam prevention
measures:

o Pluggable comment authentication. By default, Roller asks each commenter a simple math question to
ensure that they are a person and not a spam robot. Your site administrator can turn this off or replace it
with another form of authentication.

o Pluggable comment validation. Roller includes five commet validators below. Your site administrator can
adjust the settings for these validators and can enable/disable them as needed by overriding Roller's
configuration properties (seethe Installation Guide for more information).

Excess links validator will mark comments with more than three links as spam (default: on)
Excess size validator marks any comment with more than 1000 charactersas spam (default: on)

Blacklist validator will mark comments that any ofyour site's designated bad words (default on)

O O O O

Trackback verification validator will check incoming trackbacksto ensure that they link to you.
o Akismet validator allows you to use the Akismet.com spam prevention service.

o Comment throttling. If you're site is being abused by aspam robot your site adminstrator can setup
throttling, which will watch for abusers and ban IP addresses that are posting too many comments too
quickly.

But nothing beats comment moderation

Even if you've got all of those measures enabled you should still enable email notification of comments so that
you are constantly aware of new comments on your weblog. None of the measuresare 100% effective. If you are
really concerned about displaying offensive contert on your weblog even for a short time, then enable comment
moderation on yourweblog.

Three levels of blacklisting

Roller uses a blacklist, a lists of words which areused to check incoming comments, trackbacks and referrers for
spam. The blacklist includes several thousand words and regularexpressions which which are used to check
incoming comments and trackbacks. If the name, URL or content of a comment or trackback includes one of the
blacklist words or matches one of the expressons then that commentor trackback is marked as spam and is not
displayed on your weblog, unless you use the commentmanagement page to unmark it.

Actually, there are three levels of blacklist:

« Level 1 blacklist: This is the built-in blacklist, the one that comes with Roller. This can only be changed by
somebody with root access to the Roller server itself.

« Level 2 blacklist: This is the site wide blacklist, which can only be edited by aglobal administrator via the
Server Admin page.

« Level 3 blacklist: Weblog specific blacklist, which you control in the Weblog Settings page of your weblog.
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Incoming comments and trackbacks are checked againg all three levels of blacklist. Incoming referrers, however,
are only checked againgt the levels 2 and 3 blacklist.

How to add words and expressions to the blacklist

If you have a spam problem on your weblog and you'd like to add words to the blacklist, it's probably better for
you to ask your adminigrator to add the words to the level 2 blacklist for you. That way, every blogger on the site
will benefit from the addition. If you must do it yourself, here's how you do it:

Go to the Weblog Settings page and scroll down to the blacklist fields
Enter your spam words, one per line
Lines that begin wih a left parenthesis will be treated as regular expressions (see the Java API

documentation for javax.util.regex.Pattern for a guide to regular expressims). Don't try to use
a regular expression unless you really know what you're doing.

5.6 Sending trackbacks

If you are writing about something you read on another weblog, you want to let the author and readers of that
weblog know that you are doing so, and that other weblog & trackback enabled, then you should send that weblog
a trackback ping. Here's a story that illustrates how trackback works:
You read an interesting blog entry on Otto's blog. You notice that Otto's blog entry has a trackback URL,
so instead of leaving a comment on Otto's blog you decide to commentby writing a blog entry in your own
blog. You copy that trackback URL (using ALT-C, or right-click-copy, or whatever) cause you'll need it
later.
You go to your blog and write a new blog entry in response to Oto's entry. Click the Post to Weblog
button to publish your new entry. After you publish, scroll down on the New Entry page untl you see the
following text field and button:

Trackback

Trackback URL
Ihttp:.-'.-'lou:aIhost:BDBD.-'roIIerED.-‘trau:kbau:k.-‘adrninblcg.ﬂ.“.feblcga‘title_goes_here Send Trackback

Illustration 17: Send trackback control

Enter the trackback URL from Otto's blog entry into the text field and click the Send Trackback button.
Roller will respond by printing the response received from Otto's blog server. If the trackback was
successful, you should see something like this:

You should now see yourtrackback listed among the comments on Otto's blog entry.
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6 Choosing your weblog theme

A weblog theme is a set of templates, style-sheets and image that determinehow your weblog will be displayed. A
theme can define both the layout and color-schemeof your weblog. You can pick from one of a number of
predefined themes. Some themes will allow you to contrdl design by using a stylesheet. Other themes require you
to edit the templates that define the theme if you want to cusomize them.

You can access Roller's theme and template features for your weblog via the Design menu, shown below:

Create & Edit m Preferences

Theme | Stylesheet | Templates

Hlustration 18: Design menu

The Theme menu leads you to the themechooser page, shown below. Using this page you can pick from one or
more different themes for your weblog. If none of the themes are appealing to you, then speakto your site
adminstrator about obtaining or developing some additional themes. The Roller Support project & one place
where you can obtain additional themes (http:/roller.dev.java.net, not an Apache site).

lagged in as TyroneSydneyShannon - editing weblog UberHistoryBlog Front Page | Main Menu | Logout

Weblog Theme

Create & Edit m Preferences

Theme | Stylesheet | Templates

Select theme for weblog UberHistoryBlog

& Shared Theme ¢ Custom Theme

This option is for the creative hloggers who want to
be able to create a blog design of their own. Beware
though, managing a blog design of your own takes
a hit of effort.

This option is for users who don't want to fuss with
designing their wehlog on their own and prefer the
easier option of using a predefined theme

Your current theme is: Basic

Basic |

» See how your blog will look with this theme
How can you know ifthis is really the theme for you until you see it on your blog right? Click the link abova to launch
a full page preview of how your blog will ook with the selected theme.

Update Theme

For more information on cusomizing Roller themes refer to the Template Guide.
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/ _Managing your weblog preferences

As a Roller user, you are free to customize the settings of your weblog as you with. When you establish your
Roller user account, you canchoose one of the dozen or so stock themes for your website. Later, you can use the
theme switcher to switch to a different theme. Or, if you know something about HTML and CSS you can
customize the look-and-feel and layout of your weblog yourself by modifying the page templates that makeup
your site and by adding new pages.Best of all, you can do all of this through the web-based Roller Edtor UL

7.1 Weblog settings

The Preferences:Settings page allows you to set the configuration parameters for your weblog.

Weblog Settings
Create & Edit Design !rgerem:e:

Settings | Members | Pings | Custom Ping Targets | Maintenance

Here is an explanation of each of the settings on the weblog Preferences:Settings page:

7.1.1 General settings

General Settings

Title I‘(ourhlngtitle

Tagline |EII|:|g sub title

lcan |1humgnail.jpg

Aboutyour blog rore detailed description of your blog

Email address ofweblog owner I

Wehlog editor page to be used I Rich Text Editor ¢<inha) x|

Weblog is active (and should be included in community [+
listings)

Mumber of entries to display on wehlog |1 5

« Title - The title of your weblog may include HTML, but the HTML will be stripped out in your RSS feed.
You can access your title in a page template with the expression # showWebsiteTitle ()

+ Tagline — Short description or sub title of your weblog. May include HTML, but the HTML will be
stripped out in your RSS feed. You can access your tagline in a page template with the expression
#showWebsiteDescription ().

+ Icon - The image file name (ex: thumbnail.jpg) or image url (ex: http://yoursite/thumbnail.com) that shows
on some of the default themes. You'll need to upload the image via the Create & Edit:File Uploadstab
first.
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+ About your blog — A more detailed description of the blog or blog author(s) that shows on some of the
default themes.

« Email address of weblog owner. Enter the email address that you would like people to use to contact the
person in charge of your blog; usually that's you. To thwart spammers,your email address will be
obfuscated when displayed on your blog. Please enter a valid address, otherwise Roller's email features
will not work.

- Weblog editor page to be used - Choose a weblog editor page, some are rich-text editors:

- editor-text.jsp: Simple text editor, you must enter HTML
editor-rte.jsp: Rich text editor (works in Firefoxand IE but not Safari)

«  Weblog is active: un-check this box to indicate that your weblog is no longer active andshould not appear
in hot-blog and other weblog listing on the site. You might want to do this if you take a very long vacation
or if you have decided to stop updating your weblog for some other reason.

«  Number of entries to display on weblog: Enter the maximum number of entries to be displayed on your
weblog.

7.1.2 Internationalization Settings

Internationalization Settings

| publish my wehblog in multiple languages -

Show mywehlog entries from all languages on my [«

homepage
Locale | English (United States) =l
Timezone | AmericalMew_York |

+ I publish my weblog in multiple languages: check this box if you blog n multiple languages and woud
like to specify alanguage locale for each of your weblog entries.

«  Show my weblog entries from all languages on my home page: check this box if you'd like your
weblog's main page to show your pods in all languages. If you don't check it, then readerswill only see
weblog entries from your default locale.

+ Locale set the default locale foryour weblog.
- Timezone: the timezone to be used in your weblag.

7.1.3 Comments and default comment settings

Comments
Allow Comments far your weblog? [+
Moderate comments l_
Default comment settings

By default, allow comments for new entries =

Defaulttime to allow comments for new entries I unlimited days |

Apply comment defaults to existing entries (this time -
only)?
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« Allow comments for your weblog? — Check this box to allow visitors to leave comments on your weblog.

+  Moderate comments — Check this box to enable commentmoderation (i.e. you must approve each
comment before it is displayed).

-  Email comments — Check this box to receive an email notification of each new comments.

« Default from e-mail addressfor comments — This will be used as the from address in comment emails
sent by Roller.

+ By default, allow comments for new entries — Check this box to enable commentson your weblog. You
can also control comments on each individual weblog entry.

+ Default time to allow comments for new entries — Choose the default amount oftime to allow comments
for new blog entries. This setting may also be overridden using the Comment Settings section of the New

Entry page.

« Apply commentdefaults to all existing entries? - If you check this box, when you click the Save button
the comment defaults you have set will be applied to all existing comments.

7.1.4 Weblog client API

Weblog Client API

Enable Blogger and MetaWeblog APIs for your wehlog? =

Categaory for posts received via Blogger API IJ‘GeneraI =

- Enable Blogger API for your weblog - Set to true to enable weblogging via the MetaWebbg API. This
will allow you to use handy blogging clients like Ecto to post to your weblog.

« Category for posts received via Blogger API - Choose the category forincoming posts made via the
Blogger API. This only applies if you blogging client does not support categories.

7.1.5 Formatting

Formatting

Default Entry Formatters [T Convert Line Breaks
(applied in the listed arder) )
r Topic Tags

[ Email Scrambler
[ Emcticons

+  Default entry formatters: this is the list of plug-ins to be enabledby default on a new weblog entry.
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7.1.6 Spam pevention

Spam Prevention

List of words and regex expressions listed one per line
to he added to the blacklist used to check comments,
trackbacks and referrers.

+ Ignore incoming referrer URLSs that contain any of these (comma-separated) words - you can use this
to filter out what referrers are accepted. Somewhat useful if you start getting hit by referrer spam, but not a
complete solution to the referrer spam problem. See section for more information on spam prevention.
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7.2 Weblog members: managing a group blog

To create a group blog, create a new weblog or log into an existing weblog that you'd like membersto contribute

to. Creating a weblog for group blogging is the same a creating a personal weblog (see section [3] for

instructions). Navigate to the Members menu item in the Preferences tab. The Preferences:Members page

enables weblog admins to irwite members to a group blog and manage the group blog user access.

Weblog Member Permissions

F
Create & Edit Preferences
Settings | Theme | Templates | Members | Pings | Custom Ping Targets
Manage permissions of users in weblog adminblog

You can change permissions of weblog members, or remove them from the weblog
entire using the controls in the table below and clicking Save to commit your
changes. Note that you are not allowed to demote or remove yourself from the

weblog.
admin s . . '
nina - . & .

Save I

Aclions

@ Invite new member
Invite somebody to help you
write your weblog.

Whai are permissions?

Admin permission allows user
to post entries, manage weblog
and its users

Audhor permission allows user
to post entries, but not to
manage weblog

Limied permission allows user
to save draft entries only

Hllustration 19: Weblog permissions page

You can use the Invite new member link to invite any Roller user to join you weblog, but before you do you

should understand the three different permission levels allowed for members of a weblog. They are:

« Admin: an admin can create/edit weblog entries and publish them to the web. They can also manage the
weblog by changing the theme, editing the page templates that define the look of the blog, and managing
the users of the blog. Rollerwill grant you adminrights in any weblog you create. Admin users cansee

both the Create & Edit tab and the Preferencestab of Roller.

- Author: author permission allows users to create entries, edit entries and upload files. But authors cannot
change weblog settings, modify the theme or manage users. Authors can see the weblog Create & Edit tab,

but not the weblog Preferencestab.

- Limited: limited bloggers can create and edit blog entries and save them as drafts, but cannot publish them

to the web.

Select Invite new member from the right navigation to invite Admins, Authors, and Limited authors to join the
group blog. You'll need to know the users individual blog usernameto find them in the list of users. You may
scroll through the list, but it's best to begin typing their username to locate them. Set the users Permissions by
selecting Admin, Author, or Limited. Click on Send Invitation. If roller is not configired to talk to the mail

server, you may get the following messages:

User successfully invited.
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ERROR: Notification email (s) not sent, due to Roller configuration
or mail server problem.

As long as the first messageis present, the invite is successful. Thenext time the user logs mto the blog site, they
will see the message show in the screenshot below asking them to accept or decline your invitation.

Once a user is a member of your blog, you canchange their permissians. Just click the appropriate radio buton in
the table and click the Save button. You can also remove users from the site, but note that you cannot reduce your
own permissions or remove youself from the weblog.

Accept or Decline a Group Blog Invitation

If you are invited to become a member of a group blog, an invitiation will be present at the top of the Main Menu
page. Example:

Main Menu
Welcome o Roller. Use this main menu page fo edil and manage your weblogs, your user profile
and (if you have global admin permissions) administer ihe blog server.

You have one or more invitations to accept or decline:
You are invited to join weblog [adminblog] - accept | decline

Hlustration 20: Main Menu with invitation to join a group blog

Click 'accept' to become a member of the group blog or 'decline' to turn down the invitation.
Contribute to a group blog

Once you're a member of a group blog, contributing is as easy as creating blog entry content. Toaccess the group
blog, login, from the Main Menu navigate to the group blog you'd like to contibute to and select anyof the
following: New Entry, Edit Entries, Settings (weblog admins only).

For users who participate in multiple weblogs it is important to note that the Main Menu page is how you swich
between the various weblogs you can author to. The Main Menu will always show you what webbgs you are
participating in and what privilages you have on each weblog.

Resign from a Group Blog

To resign froma group blog, login, on the Main Menu page, navigate to the blog information for which you wish
to resign. Select'Resign'.
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8 Using weblog pings

Weblog update pings provide a means for you to notify aggregation and indexing sites, (for example
Weblogs.com, Technorati and javablogs.com) that your weblog has changed so that they wil pick up your latest
content from your RSS feed.

Roller supports conventional XML-RPC weblog update ping mechanismused by many sites for such
notifications.

8.1 Registering with an Aggregator

Generally speaking, aggregation sites first require you to register your weblog wih their site. During this
registration process you normally provide bah the HTTP URL and the RSS feed URL for your weblog. This is
important because the ping message conveys only the normal HTTP URL of your site, and the site will use that to
lookup the registered RSS feed URL to fetch from.

Aggegation sites that accept ping notifications generally publish the ping URL to use to ping their site on their
(human-readable) web site. Once you haveregistered your site with an aggregator, you can set up your weblog to
deliver pings to that site.

8.2 Ping Targets, Common and Custom

You can set up the Roller server to ping sites of your choice automatically wheneveryou post published updates
to your weblog.

Roller uses the term ping target to refer to a site, such as an aggregator, that accepts weblog updae ping
notifications. A ping target is configured with a (display) name and the ping URL needed to reach the site. Before
you can send a ping to a site, you must configure a ping target in Roller for the site. Roller supports the
configuration of two types of ping targets:

common ping targets

These are ping targets that are configured by aRoller administrator, and are available to beused by all
users. This allows the ping URLSs for several well-known aggregator sites to be configured once for
everybody.

custom ping targets

These are ping targets that are configured by indvidual users. If you don't find the site you wish to ping in
one of the common ping targets, you can configure your own custom ping target.

8.3 Setting up Automated Pings

Once a ping target (either acommon ping target or a custom ping target) has been configured forthe site that you
wish to ping, you can use the Weblog:Pings page (shown below) to enableautomatic pings and send manual

pings.
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Configure Automatic Weblog Pings
Create & Edit m

Settings | Theme | Templates | Members | Pings | Custom Ping Targets

Setup aulomatic pings for weblog [ad minblog]

Pings allow you to notify sites that yourweblog has changed sothat the sites can read your feed to retrieve updates. You
can enable automatic pings for sites that you wish to notify whenever your weblog changes. You can also trigger pings
manually to specific sites from this page. Nole: Mormally, you are expected to register your weblog with a site before

starting to send that site pings.

Common Ping Targets

These ping targets have been configured by the site administrator for use by all users. You can send pings to any of these

well-known sites.

blogs hitp:ping.blo.gs/ ON Disable Send Ping Now
blogrelling.com hitp:drpe. blogrolling. comdpinger! OFF Enable Send Ping Now
java.blogs hitp:dfjavablogs.comixmirpe OFF Enable Send Ping Now
Technorati hitp:drpetechnorati.com/rpc/ping OFF Enable Send Ping Now
Weblogs.com hitp:frpcweblogs.com/RPC2 OFF Enable Send Ping Now

Custom Ping Targets

These are sites you have set up for yourself as custom ping targets. These are only available for your own use.

lceRocket hitp:#rpc.icerocket. com: 10080/ OFF Enable Send Ping Now

Hlustration 21: Automatic ping configuration page

To enable automatic pings to a ping target, find the ping target on the pageand click the Enable link in the
Automatic column. The status indicator turns to ON and the link changes to Disable (as shown for some sites in
the screenshot above). To disable automatic pings to a ping target click the Disable link in the Automatic column.
The status indicator turns to OFF and the link changes to Enable.

Custom ping targets that you have configured aredisplayed on this page in a separate table below the common
ping targets; they work in the sameway. You may need to scroll down the page to see them

When you have enabled automatic pinging for a ping target, Roller will automatically send aping to that site
whenever you publish a new weblog entry orupdate a published weblog entry.

Note: In actuality, Roller queues a request to send the ping and processes this request in the backgraund,
so that you can get on with your bloging. The ping queue is processed at an interval configured by the
site administrator; this interval is 5 minutes in a default configuration. In case the aggregator site is
temporarily unreachable, Roller will requeue your ping request and retry on subsequent passes through
the queue, in a default configuration the ping is requeued for up to 3 ping attempts.
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8.4 Sending a Manual Ping

You can also send a manual ping to a ping target using the Send Ping Now link listed for the target on the
Weblog:Pings page. When you send a manual ping the ping is not queued, it is sent immediately and attempted
only once. Roller shows you the response status (success or a failure message) that results from the ping. Using
manual pings, you can test your custom ping targets to make sure that the URL you have entered is working

properly.
You do not need to enable automatic pinging in order to send manual pings. You can send a manual ping whether
or not you have enabled automatic pinging for that target.

You can use manual pings if you ping a site very rarely, or if you are feeling a bit impatient, and you don't want to
wait for the next queue processing interval.

8.5 Creating and Editing Custom Ping Targets

You should find that most popular ping targets are listed among the common ping targets and you can ping these
without needing to create a new custom one. If you don't find a common target listed for the site you wish to ping,
you have two options. You can request that your adminigrator add a new common ping target (directions in [21]);
most likely, your friendly Roller adminigrator will be happy to add new common ping targets for aggregator sites
that many other users will also be interested in using. Alternatively, you can add your own custom ping target
using the Weblog:Custom Ping Targets page.

Note: Custom ping targets are a feature that the administrator can disable. If you do not see
Weblog:Custom Ping Targets menu item, or any heading for Custom Ping Targets on the Weblog: Pings
page, then an administrator has disabled it, and you will need to contact an administrator to get a new
common ping target added.

Before adding a custom ping target, you must determinethe proper ping URL for the site that you wish to ping.
You must get this information from the aggregator's web site or from another knowledgeable source.

It can be hard to find the aggregator's documentaton telling you the specific ping URLto use to notify their site.
Commonly aggregators list this on their web site under a topic providing help about registering your feed, or
under a topic providing information for developers. Keep in mind that some aggregators only use periodic polling
and do not accept ping notifications at all. If you can't find any information about pinging on the aggregator's web
site, the site may not support pinging.

Once you have found the properping URL, you can add your custom target using the Weblog:Custom Ping
Targets page, which looks something like the following screen-shot.
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Custom Weblog Ping Targets

reaie 1

Manage cusiom ping fargets for weblog [adminblog ]

Uze this page to setup sites that you wish to ping that are not already available from the common sites. Sites will
normally advertise a ping url that you should use. Sites that you configure here are only available for your own
Use.

Ping URL

lceRocket hitp:rpc.icerocket. com: 10080/

[llustration 22: Custom ping targets page

Click the Add New button to add a new custom ping target. This will bring up a form with a Name field and a
Ping URL field. Fill in both fields, and click the Save button.

Ping Target

Ediling cusiom ping targel in weblog [ad minblog]

Mame |lceRocket
Ping URL |httpfrpc.icerocket.com:10080/

Save | Cancel I

1llustration 23: Edit ping target form

Once you have created a custom ping target, you will see it listed on the Weblog:Custom Ping Targets page.
From this page, you can further edit it or delete it. To enable automatic pings or send manual using your custom
ping targets, use the Weblog:Pings page.

The ping target's name must be unique among your own custom targets, and the Ping URL must be a properly
formed URL with a known hostname (or a raw IP address). If any of these conditions are not met, the Save will
fail, and you will get an error indication telling you what was wrong with your entry
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8.6 More on Registering with an Aggregator

When you register with an aggregator,you will usually need to provide two pieces of information as part of the
registration, your blog's base (HTML) url and your RSS feed (XML) URL. Make sure to read the aggregator's
documentation and help on registering.

For Roller weblogs, you get your weblog's base URLby viewing your weblog and takng the URL to the point
just following your weblog's handle. (In other words it should end with page/handlenamehere).

The RSS feed URL for your whole feed can be obtained by substituting page in your weblog's URL with RSS.
Most browsers will display this link in the status bar when you place your mouse over RSS badge (the little
orange XML box) on your weblog page.

You also have category-specific feeds, which are useful for registering with topical aggregators like java.blogs.
To get a category-specific feed URL, just append ? catname=/category/path where /category/path is the full
path of the category. The "basic" theme has some category RSS feeds just below the RSS badge in the right-hand
vertical bar.

Some aggregators can also scrape (read and parse the HTML of yourweblog) to discover the feed URL
automatically when provided with the HTML URL. The default Roller theme template pages include hints in the
form of tags that many sites can use to determinethe feed URL automatically.
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O Roller administration

The section of the Roller user guide is for users with the global admin role. How do you get the adminrole? The
first user created in a Roller system gets that role and then can grant it to other users via the Global Admin->User
Admin page, which just happens to be the first topc we'll cover in the section.

We'll also describe how to configure Rollervia the Global Admin->Configuration page and how to configure
Roller's custom ping facility via the Global Admin->Ping Targets page.

9.1 Managing users

The Global Admin->User Admin page, shown below, allows you to find users, edit users and create new users.

Find user to edit

STy
Global Admin Planet Admin
Configuration | User Admin | Comments | Ping Targets | Cache Info

Select user to administer

Find user by typing first letters of username or password. Select user and click edit button to edit the user's profile and
the user's weblogs.

Usarname Edit I

roller (dave. johnson@ rollerweblogger.ong) -
project (snoopdave @ ne. rr.oom)
testblog (snoopdavei@ users. sourceforge. net)
otto (otto@ rollerweblogger.org)
carl (carl@rollerweblogger.org)

New user creation

Oryou can create a new user

Hlustration 24: User admin page

To find a user, just enter the user'susername in the username in the the Username field and click the edit button. If
you don't know the user's username, then start typing what you think might be the first letters of her username or
email address and the lst-box will be populated with all users whose usernames or email addresses match. When
you see the user you want in the list box, click her and then click the Edt button to edit her user information.

You can also create a new user by clicking the create a new user link.

When a user is loaded into the Global Admin-=>User Admin page, or when you create a new user, you'll see the
form shown below. You can set the user's full name, email address, locale and timezone. You can also reset the
user's password, if you enter both a password and password confirmatim fields.
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Editing user [roller]

——
- Planet Admin

Change users profile and admin permissions

Yiou can change a user's profile, give them global admin privileges or disable them. NOTE: You can also reset a users password here, but if they uss
Roller's remnember me feature, they may have to clear browser cookies before they can login again.

Full Name IDavid M Johnson User's full name {with no HTML).

Usarnams Iroller A short one word ussrname for the user account.Pleass limit it
to simple ASCIl alphanumeric characters (a-z, A-Z and 0-9)
and do not use HTML.

Password I Usar's password.
Password (Confirm) I Confirm user's password.
Email Pave.johnmn@mllemeblogger.org Valid email address neeeded for automated notification.
Locale | English (United States) | User's preferred locale.
Timezone I EST - America/New _Yoaork ;' Usar's preferred timezone.
Enabled [ Disabled usars are unable to login to Roller.
Administrator [+ Check to give this user Global Admin permission.

Users Weblogs

Usar is a member of the following weblog(s)

Blogging Roller [roller] Mew Entry P Edit Entries i Manage
Raller: free and open source Java blog Mew Entry & Edit Entries & Manage
software [project]

Save Cancel

Hllustration 25: User admin form
You can also disable a user, which will prevent the user from logging into Roller.
Or you can check the Administrator checkbox to grant grant the userGlobal Admin privileges.
At the bottom of the page, there's a Users Weblogs section, which you can use to edit any of the user's weblogs.
This feature is here to make it easy for Global Admin's to help users who arehaving trouble with any of Roller's

features, so please use it for that reason only; don't use itto invade your user's privacy.

NOTE: you can disable a user but there is no way to remove a user from Roller.



9.2 Configuring Roller

The Global Admin->Configuration page allows you to set Roller's runtime configuration properties. It is a big
page, so we will discuss each section separately below.

Site Settings

Site Name (for main page and RSS feed) IRoIIer Site

Short name (shown in site banner) Ime Page

Site Description (for main page and RS5 feed) |A default install of the Roller Weblogger open sou

Handle of weblog to serve as frontpage blog [frontpage

Enable aggregated frontpage feeds [«

Site Administrator's email address Ida\fe@example.com

Absolute URL to site (if required) |

Suspend all ping processing? [~

Enable debug mode? [

Hlustration 26: Config page: site settings

- Site name: name of the site, to be included in site-wide newsfeeds (RSSand Atom) and on the default
front page of the Roller.

« Short name: short name of the site, to be included as the link in the banner that appears atthe top of every
page in the Rollereditor/admin UI.

- Site description: description of site, to be included in site-wide newsfeeds (RSS and Atom) and on the
default front page of the site.

+ Site Administrator's email Address: admin's email address, to be include in side-side newsfeeds (RSS
and Atom)

- Handle of weblog to serve as frontpage blog: specify the weblog that is to be displayed as the frontpage
fo this Roller site.

- Enable aggregated frontpage feeds: Set this to true if you would like the frontpage weblog's RSS and
Atom feeds to be an aggregation of all weblog on the Roller site.

- Absolute URL to this site: to be used as basis for creating absolute URLs. Required for Roller's Planet
aggregator feature.

+ Suspend all ping processing: Allows you to turn off all (outgoing) weblogs pings for all weblogs in the
system.

- Enable debug mode: currently not used.
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Comment and Trackback Settings
Allow weblog comments? |7
Allow weblog trackbacks? |,7
Autcformat Comments? ~
Escape Comment HTML? |_
Email notification of comments? [
Enable verification of trackback links? |,,_
Enable referrer linkback extraction? |_

Hllustration 27: Config: comments

Allow New Users: Set this to enable the register as new user link on the mainpage. If you turnoff user
creation, you'll only be able to create new users via the Global Admin->User Admin page.

External registration URL: Controls the URL of Roller's “Registeras new users” link. If you use an
external system to create Roller users and blogs, set the URL of that system here.

Editor pages: thisis the list of weblog editorsto be provided to users.

Allow weblog comments By un-setting this you can turn off weblog comments on all weblogs in the
system.

Allow trackbacks: By un-setting this you can turn off incoming trackbacks on all webbgs in the system.

Autoformat comments: If this is on, Roller will auto-format comments by adding in line-breaks where
appropriate.

Escape comment HTML: By setting this, you can disallow HTML in comments and thereby protect your
site from malicious JavaScript and some forms of cross-site scripting.

E-mail notification ofcomments: set this to enable email notification of new comments. This won't work
unless you configured Roller properly forsending email as described in the Roller ingallation guide.

Enable verification of trackback links: Trackback verification checks each incoming trackback to verify
that the site sending the trackback actually links to the specific weblog entry that is the target ofthe
trackback.

Enable referrer linkback extraction: NOT RECOMMENDED. This is an experimental featureand it is
not known to be working correctly.
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Newsfeed settings

Default number of entries |50

Max number of entries |50

Display styled newsfeeds for browsers o7

[lustration 28: Newsfeed settings

+ Default number of entries: default number of entries to appearin each newsfeed (RSS and Atom).

«  Maximum number of entries: maximum number of entries to be allowed in each newsfeed (RSS and
Atom).

- Display styled newsfeeds for browsers: Set to true to enable user-friendly RSS and Atom feed display, so
that users don't see raw XML when they load the feedin their browsers.

File Upload Settings

Enable File Uplcads? |,,_

Allowed Extensions hif‘jpg‘png‘jpeg

Forbidden Extensions I

Max File Size (MEB) P_m

Max Directory Size (MB) |10.no

Hlustration 29: Config page: file upload settings

- Enable File Uploads: Are users allowed to upload files?

- Allowed Extensions: Comma-separated list of file extensions that users are allowed to upload.

« Forbidden Extensions: Comma-separated list of file extensions that users are NOT allowed to upload.
«  Max File Size (MB): Maximum size of file that users are allowed to upload.

«  Max Directory Size (MB): Total upload directory sze per user.
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10 Weblog update ping administration

This section, intended for Roller administrators, describes how Roller weblog update ping feature works and how
to configure and administer it.

10.1 Creating and editing common ping targets

Common ping targets are ping targets that are shared by all users. You can create and edit common ping targets
using the Global Admin->Ping Targets page.

Common Weblog Ping Targets

Global Admin Planet Admin

Configuration | User Admin | Comments | Ping Targets | Cache Info

Manage common weblog ping targets for all weblogs.

Thes= target sites are available to all weblogs for weblog update pings.

blogs hitp://ping. blo.gs! @
blegrolling.com hitp:/frpc.blegrolling .comdpinger! 8)
java.blogs hitp:/fjavablogs.comsmirps 8‘,)
Technorati http:/frpc.technorati. comirpc/ping 8‘,)
Weblogs.ocom http:/frpcweblogs.com/RPC2 8‘,)
Add Mew |
Powered by Roller Weblogger 2.1-blogapps | Repor an lssue | User Guide | Macros | Mailing Lisk

Hllustration 30: Common weblog ping targets

You can create and edit common ping in the same way that regular users create and edit custom ping targets, but
keep in mind that common ping targets are shared amongst all users,and that your changes affectall users using
the ping target.

Administrators should make sure to test new common ping targets after creating them.

10.2 How Roller Processes Weblog Update Pings

Roller processes weblog update pings in the background. When a user updates his or her weblog, Roller
automatically queues any required automated ping on a queue. Roller only keeps one ping queue entry fora
given user weblog and pirg target. Subsequent updaes to a weblog occurring beforethe ping is processed will not
cause additional pings to be queued.

Roller makes a full pass through the ping queue at regular intervals. (Configuration of ths interval is discussed
below) In each pass, Roller will attempt to send every queued ping request once. If any send fails (and provided
the failure appears to be a transient one), the ping request will be re-queued, until the ping succeeds or a
configured number of attempts has beenmade. Note that when aping request fails and is requeued, it is
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processed again only on sutsequent ping passes. If the number of attempts to reach a given ping target reaches the
maximum without succeeding, then an error message is logged and the ping request is dropped.

There 1s currently no mechanism for alerting users of failing ping targets (though we plan some improvements in
subsequent releases to provide condition information on the weblgg Preferences->Pings page, as well as a failure
policy to deactivate persistently failing ping targets).

10.3 Configuration Properties Controlling Ping Processing

These properties contrd processing of the ping queue. They are configured in the roller.properties file.

pings.queueProcessingIntervalMins The interval in minutes between ping queue processing runs. This
must be a value in the range 0 to 120. The default value is 5 minutes.We think the default value should
work for most sites, and is tolerable for most users. The number of users publishing or updating entries in
a given interval determines the length of the queue, and Roller requires enough timein an interval to
process the queue once. We think that for all but the largest and most active sies, it can probably be
lowered as low as 1 minute if desired. IMPORTANT: The value 0 (zero) has a special meaning. If the
processing interval is set to 0, ping queue processing is disabled on the server. This can be used to exclude
all but one host from sending pings in a clustered environment wheremultiple Roller servers are sharing
one database schema. Make sure to retain one host in the cluster that does process the ping queue! If
multiple hosts in a cluster process the ping queue, you may send duplicate pings and failing ping requests
may drop out of the queue sooner than the expectedmaximum (configured by the next parameter).If no
hosts in a cluster process the ping queue, auto ping requests will accumulate in the queue and this will
eventually cause the database to run out of space, so don't try to use this as a way to disable ping features.
You can use the properties described in the folbwing sections to disable ping features.

pings.maxPingAttempts The maximum number of ping attempts made before the ping request will no
longer be requeued and will instead be dropped fromthe queue. The default value is 3. We think this value
is fine for most sites.

10.4 Suspending all ping processing

Administrators can suspend all ping processing at runtime by checking the Suspend ping processing? checkbox
under the Site Settings heading on the Global Admin->Configuration page and saving that form.

When this checkbox is set, all ping processing is suspended. New automatic ping requests are not added to the
queue, and existing entries on the queue are not processed. Manual pngs are not sent either; they result in a
message telling the user that ping processing has been suspended. Suspending ping processing is appropriate to
temporarily stop all ping processing if problems are encountered.

Unchecking the checkbox and saving allows normal ping processing to resume. Note, however, that autopings for
weblogs that are updated while ping processing is suspended will never be queued and hence never sent, but pings
queued before the suspension are sent once the suspension is lifted.

10.5 Controlling and disabling ping usage

Since use of a ping target causes an outbound network connecton to the ping site, some administrators may not
want to allow users to create their own custom ping targets. It is possible to enable or disable the use of custom
ping targets across the whole site and also to disable all ping usage. The following two properties are used to
control this.

pings.disallowCustomTargets. This property controls whether users are allowed to create custom ping
targets. If set to true, all existing custom ping targets are removed, and the Weblog:Custom Ping Targets
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page and the associated actions are disabled preventing any configuration of custom ping targets. Note:
Setting this to true this will cause the Roler server to remove any custom ping targets that users have
created when Roller is next started.

Administrators may also wish to disable ping functionality entirely. The following property, used in conjundion
with the above property, canbe used to do ths.

pings.disablePingUsage. This property controls whether users are allowed to set up automatic pings or
send manual pings. If set to true, all existing autoping configurations are removed (i.e. disabled), the
weblog Preferences->Pings page and associated actons are disabled, preventing any use of the ping
features by regularusers. Note: Setting this to true will cause the Roller server to remove any autopings
that users have configured when Roller is next started.

If both of the above properties areset to true, all ping functionality is effectively disabled for regular users. The
Global Admin:Ping Targetspage is still accessible (to adminigrators); you canuse that page to clear out any
common targets if you wish. Nouser (including administrators) will be able to configure automatic pings or send
pings. Ping queue processing continues but the queue will always be empty; you can safely disable ping queue
processing (by setting the processing interval to zero)in this situation.

10.6 Initialization of common ping targets

The initial set of common ping targets is determined bythe following configuration property.

pings.initialCommonTargets. This value is used to intialize the set of common ping targets. The value
consists of a comma-separated list of ping targets, where each ping target is specified in the form

{{name} {url}}

This value is used everytime Roller starts and finds an empty list of common ping targets. Normally, this is
only the first time Roller is started on a fresh or upgraded database; note,however, that if you really want to
maintain an empty list of common ping targets, you will need to comment out this value or set it to an empty
string.
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11 Planet Roller administration

Roller includes an aggregatorknown as Planet Roller, which makes it possible for your to aggregate together
weblogs from a Roller server with weblogs that are hosted elsewhere. You can create multiple aggregation groups
each with its own set of feeds, you can display aggregation groups on your weblog pages andRoller provides an
RSS feed for each group you create.

Roller's aggregator is not enabled by default. If you want to use it, you'll have to ask your site administrator to
enable and configure it for you. Please refer to the Roller Installation Guide for more information on that topic.

11.1 Configuring Planet Roller

If you've got Planet enabled, when you login as a global admin you'll see a Planet Administration link on the
Roller Main Menu page. Click that link to view the Planet Admin->Configurationpage, shown below.

Planet Configuration
F Y
Global Admin Planel Admin
Configurafion | Subscriptions | Custom Groups

Configure Reller's built-in newsfeed aggregator.

Set the title, description, email address and site URL to b2 included in newsfeeds produced by the aggregator. You can also setup a prowy if one is required required
by your network.

Planet Configuration Ip lanet Roller Title to be usad in newsfeed header
Description I Description to be used in newsfeed header
Site URL Ihﬂp;ﬁm”emebmgger,org URL to be used in newsfeed header
Admin E-mail Isnmpdave@users.soumaforge.net E-mail address to b2 usad in newsfeed header
Proxy Host URL I URL of proxy host (if required)
Proxy Host Port r Port of proxy host (if required)

Save

Experirmental Planst Contral
L aunch background fasks (for testing purposes only)

Refresh Entries I Synchronize Roller weblogs I

Hllustration 31: Planet config page

To configure Planet Roller, you must:

+ Ensure that your site has an absolute URL in the Global Admin-=>Configuration page in the Site Settings
section.

« If you are behind a proxy, you must enter proxy settings in the Planet Admin->Configurationpage.
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11.2 Adding external weblogs to Planet Roller

Planet Roller allows you to create multiple aggregation groups each containing a different set of feeds, but there is
also a special group known the external group that is managed by Roller. The external group includes all weblogs
on your Rollerserver plus any externally hosted weblogs you choose to add. The RSS feed for the external group
is avalable at /planetrss, so on a default Roller install its URL will be:

http:// localhost:8080/roller/planetrss

This section describes how to add andremove weblogs using the Planet Admin->Subscriptions page, shown
below.

Subscriptions

ST Ty
Global Admin Planel Admin
Configuration | Subseriplions | Custormn Groups

Subscriptions
Managing the main list of newsfeed subscriptions.

Usa this page to add and edit subscriptions: the list of newsfeed that are to be included on the main Planet aggregator
page. Toadd a new subscription simply enter title, newsfeed URL and site LURL then click the Save button.

Title: I @
Mewsfeed LIRL I Lo
Website LIRL I [*]
Existing Subscriptions
Select an existing subscription to edit.
Goldfish Chronicles (Henri) hitp:/blog .generationjava.comiroller/rss/bayard
Allen Gilliland httpe/blog s, sun.comidroller/rssigoonf
Subblebum (Valorie) hitp:#/blogs. sun.com/roller/rssfidot
Will's Head http/blogs. sun.comiroller/rssiwas

Hllustration 32: Planet subscriptions page

Adding an external weblog to Planet Roller

To add an externally hosted weblog to the Planet, use the Planet Admin->Subscriptions page. Enter it's title,
newsfeed URL and website URL and click the Save button.

Normally, you must enter all three field, but if you have a Technorati license in your classpath you might be able
to enter only the website URL and let Roller figure out the rest (by using Technorati).

NOTE: Planet Roller only supports Atom and RSS newsfeeds tha include entry level date information. If you
enter a subscription that does not include dates, Plana Roller will accept it, but you maynot see entries from the
feed because Roller will assume that it's entries are at least one day old.

Removing an external weblog from Planet Roller

You can select an existing subscription and edit it or delete it. The change will not be evident on the front page
until the next scheduled RefreshEntries task runs.
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11.3 Adding custom groups to Planet Roller

You can also add custom aggregation groups and Planet Roller will provide an RSS newsfeed for each group you
add. For example, if you add groups wth the handles music and politics, then you'll get two feeds at URLs like
this:

http://localhost:8080/roller/planetrss?group=music
http://localhost:8080/roller/planetrss?group=politics

To add new custom groups just use the Planet Admin->Custom Groups page, shown below.

Custom Planet Groups

Global Admin an min

Configuration | Subscriptions | Cusiom Groups

Add custom aggregation groups, each available as a newsfeed.

To create a group, just enter a display name and a unigue handle to be usad in the newsfeed LURL then click Save.

Title I

€

€

Handle I

Save I Cancel I

Existing Custom Aggregation Groups

Select an existing custom aggregation group o edit.

Mew Roller Bugs featured Sroup2 & &
Raoller Wiki Changes featured Groupl & &
del.icio.us del.icious & &
Roller Links rollerlinks

Hllustration 33: Planet custom groups page

To create a custom group

Go to the Planet Admin->Custom Groups page and enter the title and enter a title for the group, one that is
appropriate for display in the group's RSS feed. Enter a handle a one word name for the group, which you!'l use to
refer to the group in your page templates. When you're done click the Save button

You'll see your new group appear in the Existing Custom Aggregation Groups table. Click on the Subscriptions
icons for your new group and you'll be taken to the Planet Admin->Subscriptionspage so you can add feed
subscriptions to the group.

Enter the title, newsfeed URL and website URL for the feed you'd like to add and click the Save button to add it to
the feeds list. Repeat once for each subscription you'd like to add to the group.
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12 Apache Software License, Version 2.0

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.

"License" shall mean the terms and conditions for use, reproduction,
and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by
the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all
other entities that control, are controlled by, or are under common
control with that entity. For the purposes of this definition,
"control" means (i) the power, direct or indirect, to cause the
direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the
outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity
exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications,
including but not limited to software source code, documentation
source, and configuration files.

"Object" form shall mean any form resulting from mechanical
transformation or translation of a Source form, including but
not limited to compiled object code, generated documentation,
and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or
Object form, made available under the License, as indicated by a
copyright notice that is included in or attached to the work

(an example is provided in the Appendix below) .

"Derivative Works" shall mean any work, whether in Source or Object
form, that is based on (or derived from) the Work and for which the
editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes
of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including

the original version of the Work and any modifications or additions

to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner
or by an individual or Legal Entity authorized to submit on behalf of
the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent

to the Licensor or its representatives, including but not limited to
communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the
Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise
designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity
on behalf of whom a Contribution has been received by Licensor and
subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of,
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publicly display, publicly perform, sublicense, and distribute the
Work and such Derivative Works in Source or Object form.

Grant of Patent License. Subject to the terms and conditions of
this License, each Contributor hereby grants to You a perpetual,
worldwide, non-exclusive, no-charge, royalty-free, irrevocable
(except as stated in this section) patent license to make, have made,
use, offer to sell, sell, import, and otherwise transfer the Work,
where such license applies only to those patent claims licensable
by such Contributor that are necessarily infringed by their
Contribution(s) alone or by combination of their Contribution (s)
with the Work to which such Contribution(s) was submitted. If You
institute patent litigation against any entity (including a
cross—-claim or counterclaim in a lawsuit) alleging that the Work
or a Contribution incorporated within the Work constitutes direct
or contributory patent infringement, then any patent licenses
granted to You under this License for that Work shall terminate

as of the date such litigation is filed.

Redistribution. You may reproduce and distribute copies of the
Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You
meet the following conditions:

(a) You must give any other recipients of the Work or
Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices
stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works
that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work,
excluding those notices that do not pertain to any part of
the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its
distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained
within such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one
of the following places: within a NOTICE text file distributed
as part of the Derivative Works; within the Source form or
documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and
wherever such third-party notices normally appear. The contents
of the NOTICE file are for informational purposes only and
do not modify the License. You may add Your own attribution
notices within Derivative Works that You distribute, alongside
or as an addendum to the NOTICE text from the Work, provided
that such additional attribution notices cannot be construed
as modifying the License.

You may add Your own copyright statement to Your modifications and
may provide additional or different license terms and conditions
for use, reproduction, or distribution of Your modifications, or
for any such Derivative Works as a whole, provided Your use,
reproduction, and distribution of the Work otherwise complies with
the conditions stated in this License.

Submission of Contributions. Unless You explicitly state otherwise,
any Contribution intentionally submitted for inclusion in the Work
by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions.
Notwithstanding the above, nothing herein shall supersede or modify
the terms of any separate license agreement you may have executed
with Licensor regarding such Contributions.

Trademarks. This License does not grant permission to use the trade
names, trademarks, service marks, or product names of the Licensor,
except as required for reasonable and customary use in describing the
origin of the Work and reproducing the content of the NOTICE file.

Disclaimer of Warranty. Unless required by applicable law or

agreed to in writing, Licensor provides the Work (and each
Contributor provides its Contributions) on an "AS IS" BASIS,
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WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied, including, without limitation, any warranties or conditions
of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any
risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory,
whether in tort (including negligence), contract, or otherwise,
unless required by applicable law (such as deliberate and grossly
negligent acts) or agreed to in writing, shall any Contributor be
liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a
result of this License or out of the use or inability to use the
Work (including but not limited to damages for loss of goodwill,
work stoppage, computer failure or malfunction, or any and all
other commercial damages or losses), even if such Contributor
has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing
the Work or Derivative Works thereof, You may choose to offer,
and charge a fee for, acceptance of support, warranty, indemnity,
or other liability obligations and/or rights consistent with this
License. However, in accepting such obligations, You may act only
on Your own behalf and on Your sole responsibility, not on behalf
of any other Contributor, and only if You agree to indemnify,
defend, and hold each Contributor harmless for any liability
incurred by, or claims asserted against, such Contributor by reason
of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS
APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following
boilerplate notice, with the fields enclosed by brackets "[]"
replaced with your own identifying information. (Don't include
the brackets!) The text should be enclosed in the appropriate
comment syntax for the file format. We also recommend that a
file or class name and description of purpose be included on the
same "printed page" as the copyright notice for easier
identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License");
you may not use this file except in compliance with the License.
You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software
distributed under the License is distributed on an "AS IS" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and
limitations under the License.
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